
MEETINGS are held on 
the third Wednesday of 

the Month, at  
Christ Church 

O’Halloran Hill 1708 
Main South Road 
O’Halloran Hill at 

7.30pm 
Visitors most welcome.  
Cost $2 per family, which 

includes the Newsletter 
plus coffee/tea and 

biscuits. 
Subscriptions for twelve 

months Single $18 
Family membership $24 
Novice and experienced 
computer users will be 

warmly welcomed  

SOUTHERN DISTRICTS COMPUTER 
USERS CLUB INC.  

 June 2007 

Urn Warren                          4th June 
George Cetti                        8th June 
Harry Westwood                 8th June 
Margaret Winstanley         10th June 
Ed Uden                             14th June 

Southern Districts 
Computer Users Club 

Inc. 
For further information 
about S.D.C.U.C.Inc. 

 
Contact The Club President,  

Jim Greenfield 83824912 
 

Correspondence to 
The Secretary 
S.D.C.U.C.I. 

Box 991 
Morphett Vale  5162 

Email to 
roymarj@optusnet.com.au 

Club Web Site    http://videocam.net.au/sdcuci/index.html 

THE THOUGHT FOR THE MONTH 
One ought, every day at least, to hear a little song, read a good poem, see a fine picture, and if it were 

possible, to speak a few reasonable words.        Johann Wolfgang von Goethe (1749 - 1832) 

 
THE PRESIDENT’S   PAGE 
Hoax virus warnings and chain letters 

 
We all need to be vigilant against computer viruses. 
I would hope that we are also mindful of the misfortunes of other people around 
us. 
From time to time I receive emails reminding me of these two desirable attributes  
Most times these emails messages are hoaxes. 
An example of an hoax email I received this week.   
  
I am 7 years old, and I have severe lung cancer . I also have a large tumour in 
my brain, from repeated beatings. Doctors say I will die soon if this isn't fixed, 
and my family can't pay the bills.  
The Make A Wish Foundation, has agreed to donate 7 cents for every time  
this message is sent on.  
 
 
An example of a hoax email virus warning.  
 
This information arrived this morning, from Microsoft and Norton.Please send 
it to everybody you know who accesses the Internet. You may receive an 
apparently harmless email with a PowerPoint presentation called "Life is 
beautiful.pps." If you receive it DO NOT OPEN THE FILE UNDER ANY 
CIRCUMSTANCES, and delete it immediately. If you open this file, a message 
will appear on your screen saying: "It is too late now, your life is no longer 
beautiful", subsequently you will LOSE EVERYTHING IN YOUR PC and the 
person who sent it to you will gain access to your name, email and password.  
This is a new virus which started to circulate on Saturday afternoon.  WE 
NEED TO DO EVERYTHING POSSIBLE TO STOP THIS VIRUS.  UOL has 
already confirmed its dangerousness, and the antivirus Softs are not capable of 
destroying it.  The virus has been created by a hacker who calls himself "life 
owner", and who aims to destroy domestic PCs and who also fights Microsoft 
in court!  That's why it comes disguised with extension pps. He fights in court 
for the Windows-XP patent. MAKE A COPY OF THIS EMAIL TO ALL 
YOUR FRIENDS. 
 
I urge you before sending CHAIN EMAILS to go on the internet (Google) 
to check if the message you are sending is genuine. 
Do not support Hoax Messages and Hoax Virus warnings. 
Do not clog up the internet with fake information. 
Do not clog up the internet with chain letters 
 
Jim Greenfield                                                   President 
 
 

Editor Colin Campbell 



Error Messages in Microsoft Operating Systems 

Most PC operators have encountered Error Messages popping up in 
Microsoft®, sometimes these are easily remedied by looking for the file 
causing the error and deleting or reinstalling the offending program. Often the 
error message will mean nothing to the average user. Take a note of the 
message. Ignore any list of numbers/addresses and copy the text message. 
Frequently, opening Google and inserting the message as a search string will 
get answers. Sometimes the answer sites will tell you what to do to fix the 
problem but after paying a fee.  

Microsoft ® have their own very extensive Knowledge Base that more often or 
not, will prove to be most useful in understanding and remedying the Error 
Message. Go to <http://search.support.microsoft.com/search/default.aspx> 

At the search page, you can select the Microsoft Software being used, type the 
error message and the search engine will find a list of Articles that contain the 
message in priority order. Each article has an Article Number and more often 
than not, has links to other articles that may be useful. 

 Getting to know how to use the Knowledge Base is a good skill to master. 

 

 

JUNE; the sixth month on the Georgian Calendar. Named after the 
Roman Goddess Juno, wife of Jupiter. Astrological Star Sign Gemini rises 
into June and the Winter Solstice (shortest day) occurs Friday 22nd. The 
Pagans referred to the winter solstice as happening at Yule, the bottom of 
their Wheel of the Year. Of course, in the northern hemisphere, this 
happens to coincide with the Festive Christmas. If you have a Birthday 
today, 20th; you share with film stars Errol Flynn, Audie Murphy and John 
Goodman. It is National Rose Month in the USA and in the Roman 
Catholic Calendar, June is devoted to the Sacred Heart of Jesus. 
Check out Wikipedia on-line at <http://en.wikipedia.org/wiki/Main_Page>  for more about June 
 

Is this Enough Petrol for 
you? 
 
One of the four-trailer  BP Su-
per-Tankers that operate in the 
NT. (Daly Waters) 
 And we thought that some ser-
vice stations are hard to get into 
with the caravan 



 
 
 
 
 

Established 1991 
 

 0422 912 583 
Web Design               Hosting             Domain Names 

 
Personalised Service 
http://vcsweb.com 

eBay Sales  
We have great items for gifts such as Playstation & Gameboy accessories, phone covers,  

wheat bags, laser pointers, chess sets and more. 
Buy online and pick up locally! 

http://www.stores.ebay.com.au/vcswebgoodiesbox/ 
 

We can also sell items for you.   
Contact us for details! 

Last Months Word Find: how did you do? 
 

AXWORD finds the following ordinary (?) words: 
comp; gimp; gump; mico; ming; mino; mint; mong; motu; moup; mung; muon; 
omit pium; tump; compt; cumin; guimp; impot; mount; mucin; mungo; muton; 
nomic; notum; ogmic; timon; coming; gnomic; impugn; moping; muting; umping; comping; 
tumping; computing 
 
36 Words (Search restricted and filtered to be common words, no names or foreign, four to nine letters)  



 

 

Automotive Repairs 
 

ALL GENERAL  
MECHANICAL REPAIRS 

Brakes, Suspension, Clutch, 
Auto Trans Service, 

Wheel Balance & Repairs, 
New & S/Hand Tyres. 

SERVICE, TUNE & SAFETY CHECK 
(most 4 & 6 cyl. cars) - Includes plugs, 

points, oil, filter. 
 

U4/2 Somerset Circuit 
Lonsdale S.A. 5160 
 8186 0081 

Pensioner 
& Seniors 
Discount 

 MEETING RULES 
 

NO SMOKING    NO DRINKING   NO SWEARING 
 

We are allowed to use the facilities at Christ Church, O’Halloran Hill in return of a small fee plus respect for their property. We 
ask for your co-operation in respect to the above. While we can not control what our members do away from our club meetings, 
Piracy of copyright material can not be condoned at our meetings. 

Have you recently acquired, or do you just want to learn more about  
operating your computer? 

The Club conducts classes on a wide range of subjects, at a very moderate charge 

The Maximum number in class is four  

(Our aim is to conduct the classes in a friendly non threatening atmosphere) 

Some of the classes that are available 

1. Basic Computing (Stage one and / or Stage Two) 

2. Advanced Word 

3. Internet workshops 

4. Digital Cameras 

For more information contact a committee member. 

 
 

 

 
MSWord Format:- Indents 

and Spacing 
 

Word allows you to adjust the line and 
paragraph spacing to make your 
document look better. By default, spaces 
are single and sized to the font size. 

When using titles and paragraphs, set the 
spacing between paragraphs and headings 
by opening the Format Tab, select 
Paragraphs and in the Paragraph 
Dialogue Box, you can change the 
spacing before the highlighted paragraph, 
(ie: between the header and the first line); 
spaces in the paragraph, single, one and a 
half or double line. You can specify a 
different space dimension after the 
paragraph. 

If you are using a larger Font for the 
Header, the spacing will be better if you 
change the spacing before the paragraph, 
looks better and avoids the use of ugly 
hard returns to space out your work.. 
Check out the rest of the Dialogue Box. 

 



Opinions expressed in this newsletter do not necessarily represent those of the Southern Districts Computer Users Club Inc. nor does publication of an 
advertisement imply endorsement by the Southern Districts Computer Users Club Inc.  
 
While every attempt has been made to verify that the information in this newsletter is correct, the Southern Districts Computer Users Club Inc accept no 
responsibility for any inaccuracies. 
 
Likewise no member of the committee or member of the Southern Districts Computer Users Club will accept any liability for any damage occurring to a 
computer or to any computer systems from following instructions given in this newsletter. 

 
Windows XP TOOL BOX 

Practical hints for the serious Tinkerer 
 
Note: The Editor has extracted these tips and info off of Internet Help Pages. 
To seek your own hints, Search with your favourite search engine and try “XP Help” or “XP 
Tips”  
 
 

Tip: Increase available disk space by scaling back System Restore.  
 
 
It's not perfect, but Windows System Restore is a useful first step in recovering your PC or drive 
from a major system error. However, it can consume more than 10 percent of your total hard drive 
space.  
If you find yourself desperate for an extra few gigabytes — particularly on secondary storage 
drives — there's an easy way to reclaim data space by simply limiting the number of System 
Restore points Windows XP establishes. This one's a snap and there's no tangible increase of risk, 
which is why we love it. 
  

1. Right-click on My Computer and select Properties > System Restore.  

2. If you have just one hard drive, skip to step 3. Otherwise, select the drive on which you 

want to gain storage space and click the Settings button.  

3. Adjust the slider to the left to use less disk space, and Win XP will reduce the number of 

System Restore points by the appropriate amount.  

Microsoft Word, other word processors and text programs  

 

Every Word document has a template associated with it. Templates control things like which styles and 
macros are available to the document. A document can have only one template associated with it at a 
time, and you can change that template at any time you desire. 

If you want to find out which template is attached to a document, you can do so by choosing Templates 
and Add-Ins from the Tools menu. (In Word 2007, display the Developer tab of the ribbon and then click 
on the Document Template option.) Word displays the Templates and Add-ins dialog box.  

The field at the top of the dialog box indicates the name of the template associated with your document. 



 
Computers and More Word-Find 

 
 

R E R O L P X E D F S E L I F 
O W E B P A G E O X R N A T E 
S P R E A D S H E E T L N S I 
S S E N T H G I R B D A I A K 
E R W B T F O S O R C I M R S 
C J V I D E O C A R D D R T I 
O R G W I N D O W S X P E N D 
R E D R A O B Y E K L A T O O 
P T D H A R D D R I V E S C W 
O U D R E P A R A A R W F B N 
R P U H I M H M O N I T O R L 
C M T R O V E I E K W S D O O 
I O B U L C E T C I D V H G A 
M C S P Y W A R E S W O R B D 
M E D O M T T E S P I H C P T 

 
 
Brightness; Browser; Chipset; Club; Computer; Contrast; Dial; Disk; 
Dos; Download; Drivers; Email; Explorer; Files; Graphics; Harddrive; 
Internet; Isp; Keyboard; Microprocessor; Microsoft; Modem; Monitor; 
Motherboard; Mouse; Ram; Spreadsheet; Spyware; Terminal; Videocard; 
Webpage; Windowsxp. 

Have you been vaccinated against Influenza yet? 
 
The flu season is again upon us, and older people and those who are ill are being urged to get their annual 
vaccination to protect against the coming flu season. 
Health Minister John Hill said those who have a higher risk of infection are at the greatest risk. “People should be 
getting their flu shots now, not waiting until the colder weather hits,” he said. 
“Influenza has the potential to hit hard every winter, and people who are considered at risk — those with chronic 
diseases like diabetes or heart and lung problems, and older people — are particularly vulnerable 
 
Flu vaccine is free for people over 65 years of age, who I would urge to take up this offer for free vaccination. Older 
people should contact their GP for further information or to arrange a vaccination — and while the vaccination itself is 
free, they will still need to pay the usual fee or gap payment for a doctors’ visit. The SA Health Department also 
recommends people in nursing homes and long-term care facilities are vaccinated, including health care workers who 
have contact with people in high-risk groups. 
For further information or advice, contact the SA Health Department’s Immunisation Coordination Unit between 9am 
and 4:30pm weekdays on 8226 7177. 
 
 
(Reprinted from MYCOTA, magazine for the over 50s, June/July. SDCUC is a Community Organisation Member of COTA, 
Council On The Aging, SA) 



The good Lord awoke one winter morning, it was rather late 
And all what happened in this story is just history and fate. 
Let it be a lesson and moreover let it show 
That not even God’s infallible when he’s got a hangover. 
If it was cold in heaven., it was freezing down on earth 
for all this happened before the invention of hearth. 
All the creatures were praying for this killing cold to pass 
but it was too late for one monkey, who was made of brass. 
All this prater exceeded one hundred decibels 
And was heard not only in heaven, but in hell as well. 
The Devil himself could not stand this hellish racket 
So he took pity on them and gave them fire in a bucket. 
This first bucket was very small, rather like a tin 
The heat it gave was negligible, the smoke was very thin. 
But it grew and grew till it became very big 
The heat was that of a furnace, the smoke was very thick 
It seeped through the doors, windows and holes in ceiling 
crest 
Till it was reminiscent of smoke signals from the wild, wild 
west. 
There were fumes that induced tears and coughs, but after 
There were ditty jokes and laughter. 
And on that winter morning, just before the dawn 
The first and last intelligence on earth was born. 
And it was just about then that the proverbial hit the fan. 
Earth heated up, in the region of the arctic belt 
the glaciers and ice caps were beginning to melt. 
The sea began to rise, the price of land was in an upwards 
spin 
And people from submerged homes were told to learn to 
swim. 

Then the miracle did happened, never to be repeated  
The Lord himself descended from heaven 
of course it is electrically heated. 
And what happened afterwards may be hard to swallow 
when in the gentle noise of a wounded elephant he did bellow “Clean 
air is my deepest desire. 
Thou shall not fart round here any more! 
 (as an afterthought) and get rid of that lire!”. 
So that bleak winter morning, colder than most 
A puff of smoke rose up to heaven, and the bucket gaveth up its 
ghost 
With the bucket died the fire, with the fire died the smoke and there 
between the last glow of dying hearth 
died the last vestige of solidarity on earth. 
The air became clear, visibility extended beyond the door 
jokes became cleaner, but nobody laughed any more 
 and all the beautiful things like friendliness and fun, 
 with sex an exemption,  
started down the road to inevitable extinction. 
Humanity, as always, being a greedy lot 
Divided itself to the ones who “have” and the ones who “have not” 
Those who “have” did not want to give 
And the “have not” lost all the will to live.  
They petitioned the Lord for the earth’s annihilation 
 they pestered him day and night 
till one day He weakened and in a state of inebriation 
 Said ---‘right…! 
oooooopppss! 

FINAL SOLUTION TO THE POLLUTION 

And now only icy clear air, as it passes over the emptiness where the earth used to be, wails a requiem for the demise of the 
blue planet and it’s living things. There may be a day, it just may be, when God is old and lonely, that he might once more 
say….”let there be light”! 
 
Amen ;  JC  ISC, (OB) 

 
 

Fleurieu Peninsula Family History Group Inc  
 

Quiz Night   25th August 
 
Our next major fundraising event will be our Quiz Night on Saturday 25th August.  
It will be 7pm for a 7.30pm start.   
Mark Lang will be our Quiz Master as in other years,  and you can book tables of 8 
or come along individually.  You don't have be intelligent, just come and have a fun 
evening.  . 
 

Venue for this Quiz Night is Uniting Church Hall, 
William Road, Christies Beach. 



Several computers, P166 to P600, complete systems and/or 
CPU boxes only. Also old style RAM, small hard drives, net-
work cards, sound cards and cables. 
Prices very negotiable; Other parts for the tinkerer. 
Second box for LP recording?  

Colin 83836021 

Members Market  

Monitors, two 21-inch CRT monitors, ex Club display units. $60 
each payable to the club. See Jim Greenfield to arrange 
testing and viewing. 

TAX HELP 
 
Would you like help to prepare your Tax Return this year? 
COTA provides a free Tax Help Program, mainly for individuals aged over 50 years. 
This is a free service by trained volunteers to assist with simple and straightforward tax 
returns. 
To make an appointment to complete returns, phone COTA on 8232 0422 from 2nd July 
2007 until 28th September at 45 Flinders Street, Adelaide. 
 
Clubs on the Move Bulletin, May-July; COTA-SA 

 

MEETING  NOTES: 

Bird Cage,  white; new and unused, suitable for smaller parrots or 
Budgie. Approx 50x50x65cm.  Offers around $35; Colin 83836021 


